
UC Irvine
UC Irvine Previously Published Works

Title
Live-cell biosensors based on the fluorescence lifetime of environment-sensing dyes.

Permalink
https://escholarship.org/uc/item/5hb1z3rp

Journal
Cell Reports: Methods, 4(3)

Authors
Mehl, Brian
Vairaprakash, Pothiappan
Li, Li
et al.

Publication Date
2024-03-25

DOI
10.1016/j.crmeth.2024.100734
 
Peer reviewed

eScholarship.org Powered by the California Digital Library
University of California

https://escholarship.org/uc/item/5hb1z3rp
https://escholarship.org/uc/item/5hb1z3rp#author
https://escholarship.org
http://www.cdlib.org/


Report
Live-cell biosensors based
 on the fluorescence
lifetime of environment-sensing dyes
Graphical abstract
Highlights
d Characterize solvent-dependent fluorescence lifetimes to

generate live-cell biosensors

d Dye-protein conjugate changes lifetime upon binding

activated Cdc42

d Quantifies the concentration of a specific Cdc42

conformation in cells

d FLIM biosensor used in cells to report localized Cdc42

activity during cell protrusion
Mehl et al., 2024, Cell Reports Methods 4, 100734
March 25, 2024 Crown Copyright ª 2024
https://doi.org/10.1016/j.crmeth.2024.100734
Authors

Brian P. Mehl, Pothiappan Vairaprakash,

Li Li, ..., Enrico Gratton, Bei Liu,

Klaus M. Hahn

Correspondence
beiliu@pku.edu.cn (B.L.),
khahn@med.unc.edu (K.M.H.)

In brief

Mehl et al. construct biosensors based on

dyes whose fluorescence lifetimes

respond to their solvent environment.

Lifetime changes of a biosensor reflect

the changing level and location of Cdc42

activation during cell protrusion and

enable quantitation of the activated

concentration in cells.
ll

mailto:beiliu@pku.edu.cn
mailto:khahn@med.unc.edu
https://doi.org/10.1016/j.crmeth.2024.100734
http://crossmark.crossref.org/dialog/?doi=10.1016/j.crmeth.2024.100734&domain=pdf


OPEN ACCESS

ll
Report

Live-cell biosensors based on the fluorescence
lifetime of environment-sensing dyes
Brian P. Mehl,1,5 Pothiappan Vairaprakash,1,5 Li Li,1 Elizabeth Hinde,2,3 Christopher J. MacNevin,1 Chia-Wen Hsu,1

Enrico Gratton,2 Bei Liu,1,4,* and Klaus M. Hahn1,6,*
1Department of Pharmacology, University of North Carolina at Chapel Hill, Chapel Hill, NC 27599, USA
2Laboratory for Fluorescence Dynamics, Department of Biomedical Engineering, University of California at Irvine, Irvine, CA 92617, USA
3Present address: School of Physics, The University of Melbourne, Melbourne, VIC 3010, Australia
4Present address: National Biomedical Imaging Center, College of Future Technology, Peking University, Beijing 100871, China
5These authors contributed equally
6Lead contact

*Correspondence: beiliu@pku.edu.cn (B.L.), khahn@med.unc.edu (K.M.H.)
https://doi.org/10.1016/j.crmeth.2024.100734
MOTIVATION Fluorescent biosensors that read out protein activity as changes in the fluorescence lifetime
of incorporated dyes can avoid artifacts associatedwith other designs and can be used to quantify the intra-
cellular concentration of specific conformations. Here, we identify dyes suitable for live-cell imaging that
undergo solvent-dependent changes in lifetime and construct a biosensor reporting the conformation of
endogenous Cdc42 in living cells.
SUMMARY
In this work, we examine the use of environment-sensitive fluorescent dyes in fluorescence lifetime imaging
microscopy (FLIM) biosensors. We screened merocyanine dyes to find an optimal combination of environ-
ment-induced lifetime changes, photostability, and brightness at wavelengths suitable for live-cell imaging.
FLIMwas used tomonitor a biosensor reporting conformational changes of endogenous Cdc42 in living cells.
The ability to quantify activity using phasor analysis of a single fluorophore (e.g., rather than ratio imaging)
eliminated potential artifacts. We leveraged these properties to determine specific concentrations of acti-
vated Cdc42 across the cell.
INTRODUCTION

Fluorescent biosensors have been a powerful tool for untan-

gling signaling behavior in living cells.1–6 Most often, they

have been based on fluorescence resonance energy transfer

(FRET), with readouts quantified using ratiometric fluorescence

intensity measurements. Although ratiometric imaging can

achieve fast acquisition with relatively high signal-to-noise ratio,

fluorescence lifetime imaging microscopy (FLIM) can provide

important advantages over FRET and other biosensor ap-

proaches.7–9 Unlike some ratiometric biosensors (e.g., those

using two fluorophores on separate protein chains), single-

dye FLIM biosensors do not need corrections for varying

biosensor concentrations across the cell. In FRET biosensors,

two fluorophores can bleach at different rates, complicating

quantitation of photobleaching effects. It is difficult to distin-

guish between true FRET changes (reflecting actual biological

interactions or conformational changes) and artifactual

changes (due to incomplete folding, variable expression, or

photobleaching) because all these changes manifest as alter-
Cell Repor
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ations in fluorescence intensity at similar wavelengths. Using

a single fluorophore on the biosensor simplifies multiplexed

imaging.10–13

FLIM was previously explored for intracellular biosensor imag-

ing, including studies of NAD(P)H,14 calcium,15,16 sodium,17 and

protein conformation. For the latter, FLIMwas used largely to im-

age FRET,8,9,18–21 but FLIM biosensors based on single dyes

have the potential for brighter emission than FRET because the

dyes are directly excited.22–24 Environment-sensing dyes have

been monitored in cells using fluorescence intensity

changes,22–26 but biosensors based on the FLIM of such dyes

remain largely unexplored.27,28

For biosensors, environment-sensing dyes have been

attached to target proteins,6,29 where they are affected by

conformational changes,30–32 or to ‘‘affinity reagents’’ (ARs)

that bind selectively to the activated conformation of the target,

causing a spectral change in the attached dye when the AR

binds its target.22,24 ARs have been based on proteins, peptides,

or even small molecules22,24,33 (Figure 1A). They can report the

activation of endogenous, unmodified targets.
ts Methods 4, 100734, March 25, 2024 Crown Copyright ª 2024 1
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Figure 1. Dye-based biosensors

(A) The dye-based Cdc42 biosensor consisted of an AR that specifically binds

to the active conformation of Cdc42, with a covalently attached environment-

sensing dye (red). Upon Cdc42 activation, the AR bound to Cdc42, altering the

dye’s local environment and affecting optical properties, including brightness

and fluorescence lifetime.

(B) Parent dyes (left) and derivatives with a cysteine-reactive linker (middle).

Pht, phthalimide; BA, barbituric acid; TBA, thiobarbituric acid; SO, benzo-

thiophene. n indicates the number of double bonds as shown in the structure at

top. mero81 and mero77 are based on the red-shifted fluorophore.

(C) Phase lifetime measurements of parent merocyanine dyes in DMSO,

methanol, and butanol (n = 3, data shown as mean ± SD).
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Here, we make a FLIM-based biosensor by attaching a mero-

cyanine dye to an AR that selectively binds the activated confor-

mation of Cdc42. Such a biosensor was previously constructed
2 Cell Reports Methods 4, 100734, March 25, 2024
using dyes undergoing intensity changes,24 and we here take

advantage of the previous biochemical characterization of that

biosensor, constructing it again but with dyes for FLIM readouts.

Dyes were screened for optimal fluorescence and solvent-sensi-

tive lifetime, and the dye with the best combination of brightness

and lifetime response to Cdc42 binding was used in the final

FLIM biosensor.23–26 The final FLIM biosensor provided sensitive

readouts of Cdc42 activity in living cells. By adapting an

approach used for calcium biosensors, we were able to deter-

mine the actual concentration of activated species, not just the

relative distribution of activity. In summary, our results identify

dyes suitable for FLIM biosensors and show how they can be

used to quantify the subcellular concentrations of activated

Cdc42. This can be a paradigm for the application of the dyes

to other proteins.

RESULTS

Merocyanine dyes
Merocyanine dyes can show changes in quantum yield, extinc-

tion coefficient, excitation maxima, and/or emission maxima

when placed in different solvent environments.23,26,34–38 Dyes

selected for photostability, brightness, and emission greater

than 595 nm in DMSO23 were tested for FLIM changes that could

be used in biosensors. Merocyanine dyes are characterized by

electron donor and acceptor moieties linked together through

conjugation. An indolenine donor can be combined with different

strong electron acceptors to produce merocyanines with a use-

ful compromise between brightness, photostability, and environ-

ment-sensitive fluorescence.23,25,26,36,37 Here, we linked indole-

nine to phthalimide (Pht), barbituric acid (BA), thiobarbituric acid

(TBA), and benzothiophene (SO) (Figure 1B). Simple versions of

the dyes, without reactive side chains, were assessed for FLIM

and other fluorescence properties. Useful fluorophores were

then derivatized with a cysteine-selective linker for attachment

to the AR (Figure 1B). We examined four dyes with known favor-

able fluorescence properties, previously used in biosensors but

not for FLIM, and one red-shifted dye synthesized for this study,

potentially useful for multiplexed imaging. The dyes were

screened for the sensitivity of their fluorescence lifetimes to envi-

ronment. Figure 1C shows the measured phase lifetimes, tp, for

each of the parent dyes prior to attachment of the cysteine-reac-

tive linker. Lifetime was measured in three solvents with different

polarity and hydrogen-bonding strengths.39 The parent mero-

cyanine dyes included mero50, mero51, mero89, and

mero88,23 all of which contain an indolenine donor but different

acceptors (Pht, BA, TBA, and SO). The previously unpublished

dyes, mero81 and mero77 (Figure 1B), had extended polyene

systems that produced red-shifted absorption and emission

spectra valuable for multiplexed imaging applications (Figure 2).

They were shown to have photostability greater than Cy5, a well-

known dye used for live-cell imaging (Figure S1A).

All parent dyes had lifetimes in the nanosecond range, suitable

for current lifetime instrumentation.40 The shortest lifetimes were

observed when the parent dyes were measured in the strongly

polar, hydrogen-bonding solvent DMSO. In contrast, the longest

lifetimes were observed in the least polar hydrogen-bonding sol-

vent, butanol. Response to environment can be seen as resulting



Figure 2. Photophysical properties of mero77 and mero81
(A) The excitation and emission spectra of mero77 dissolved in DMSO.

(B–G) Emission spectra (B) and normalized emission spectra (C) of mero81, excitation spectra (D) and normalized excitation spectra (E) of mero81, absorption

spectra (F) and normalized absorption spectra (G) of mero81.

(H) Molar extinction coefficients of mero81 at lmax.

(I) Solvents used in (B)–(G).
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from differential solvent interaction with specific resonance

structures41–44 or electron distributions.34–37

In vitro assay of biosensor response
The solvent dependence of dye lifetimes was promising, but it

was hard to predict how a given dye would change FLIM when

attached to an AR and exposed to a given protein (see discus-

sion). Therefore, each dye was tested in an actual Cdc42

biosensor. A water-soluble, cysteine-reactive side chain was
attached to each dye for covalent coupling to the single cysteine

of the AR. This was based on the approach previously used to

attach intensiometric dyes to the same cysteine.24 The AR was

based on the Cdc42-binding domain (CBD) of Wiskott-Aldrich

syndrome protein.23,24 It has been shown that this domain binds

selectively to the activated, GTP-bound conformation of

Cdc42.45 In vitro assays were performed to measure the differ-

ence in lifetime between bound and unbound biosensors. The

final products were named mero-CBD biosensors,23 with the
Cell Reports Methods 4, 100734, March 25, 2024 3



Figure 3. In vitro assay for lifetime changes associated with Cdc42 binding and measurement of endogenous Cdc42 activation

(A) Phasor histogram ofmero87-CBD biosensor (400 nM) in the presence and absence of 12 mM constitutively active Cdc42 mutant (Q61L). Excess Cdc42 was

used to shift the equilibrium of the biosensor to the bound form. G = M*cos4; S = M*sin4, where M is the modulation and 4 is the phase shift in the frequency

domain measurements.8,13,47

(B) Bar graph displaying phase lifetimes13 of biosensors made with the indicated dyes (n = 3, data shown as mean ± SD).

(C–E) Intensity (C), activated Cdc42 concentration (D), and phasor histogram (E) for cells injected withmero87-CBD (12 cells) ormero87-mCBD (AR mutated to

abrogate Cdc42 binding; 7 cells). The phasor histograms are labeled with the locations of free and bound biosensors (solid red circles). The hash marks indicate

10% increments of protein activation. Scale bar: 10 mm.
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number denoting the dye (e.g., mero87-CBD for the AR CBD

labeled with dye mero87).

The phasor approach is a powerful way to visualize lifetime

changes without the aid of complex fitting routines.13,46,47 Fig-

ure 3A shows a phasor plot of mero87-CBD in the presence
4 Cell Reports Methods 4, 100734, March 25, 2024
and absence of a constitutively active Cdc42 mutant (Q61L).

The free and bound forms of the biosensor had unique phasor lo-

cations within the phasor plot, defining characteristic lifetimes

for each state. Utilizing the property of linear combination, a pha-

sor that contains a portion of free and bound biosensors will be



Figure 4. Phasor analysis and FLIM imaging of mero87-CBD in a migrating mouse embryonic fibroblast (MEF) cell

(A) The phasor plot ofmero87-CBD co-expressed with constitutively active Cdc42 in living cells showed that bounded biosensors could reach an extreme (2 ns)

similar to that seen in vitro (Figure 3B).

(B) The slight discrepancy between the in vitro and live-cell measurements of phasor locations causes negligible changes in quantified concentrations. The

simulation used the KD of mero87-CBD binding to Cdc42 with the assumption that the activation level was at 10%.

(C) Time course of the distribution (top) and fraction activated (bottom) of mero87-CBD in a migrating MEF cell. The cell was continuously imaged until it was

completely photobleached at 30 min.

(D) Fractional contribution changes upon activation for a dye-based biosensor: brightness ratios of the free to the bound form are 1.0 (solid blue) or 0.1 (dashed

blue). Dye-based FLIM biosensors are most sensitive to activation changes when protein activation levels are low. Scale bar: 10 mm.
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located somewhere along a line connecting the two distinct

states. We observed that upon biosensor binding to Cdc42,

the lifetime of all tested biosensors increased (Figure 3B). Addi-

tionally, the phasors did not lie on the ‘‘universal circle,’’8,13,47

indicating complex decay kinetics.

All Cdc42 biosensors exhibited an appreciable change in life-

time. Mero87-CBD showed the largest difference between the

free and bound conformations. Although dyemero81 performed

the best in solvent tests (Figure 1C), the biosensor derived from it

(through reaction with mero77, its reactive derivative) showed a

relatively weak response to Cdc42 binding. This again showed

that response to proteins is complex and that dye selection for

a given biosensor cannot be based simply on the performance

of free dye in solution. We chose to pursue mero87-CBD

because of its strong response to Cdc42. Changes in pH over

the physiological range minimally affected the fluorescence of

the attached dye (Figure S1B). The small changes observed

outside this range were likely due to effects on the AR, not the

dye, as there were no dye functional groups with pKa near this

range.
Fluorescence lifetime imaging in living cells
NIH 3T3 mouse embryonic fibroblasts were microinjected with

mero87-CBD and imaged on a confocal FLIM microscope.

FLIM allowed us to visualize both the distribution of the

biosensor (Figure 3C) and the absolute concentration of active

Cdc42 (Figure 3D; STAR Methods). We used phasor locations

of the free and bound biosensors from the in vitro assay (pf

and pb, respectively, solid circles; Figure 3E, column 3); phasor

locations determined in cells were comparable (Figures 4A and

4B; data are available at Zenodo, https://doi.org/10.5281/

zenodo.10654587). The increase in emission intensity produced

by binding active Cdc42 resulted in a nonlinear relationship be-

tween the fraction of activated protein (hash marks, increments

of 10%) and the fractional contribution of each species to the

overall lifetime (see discussion). Cells loaded with the wild-type

biosensor (Figures 3C–3E, columns 1 and 2) had phasors that

displayed a smear along the line connecting the two states, indi-

cating a distribution of Cdc42 activity within the cells. The major-

ity of pixels ranged between 0% and 10% of what would be

observed for a fully bound biosensor, as indicated by the first
Cell Reports Methods 4, 100734, March 25, 2024 5
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two hash marks. This was consistent with previous biochemical

studies.48,49 It is noteworthy that this relatively small change in

binding produced a readily discernable change in lifetime shown

by the phasor plot (see discussion). In the negative control cells

where a mutation of the AR abolished the interaction with Cdc42

(Figures 3C–3E, column 3), the measured lifetimes were

bunched near the free form of the biosensor, signifying negligible

Cdc42 activation.

Knowledge of active protein concentrations provides informa-

tion valuable for the understanding and quantitative modeling of

biochemical regulatory cycles. The spatial distribution of active

Cdc42 concentrations across individual cells was calculated

by analyzing phasors as described in the STARMethods section

(Equation 5). Shown in Figure 3D are the pseudo-colored, map-

ped concentrations of active Cdc42. Endogenous Cdc42 activa-

tion was observed near protrusions, consistent with previous re-

sults24,50 (Figures 3D and 4C).

DISCUSSION

Here, we evaluated a series of bright dyes that showed solvent-

induced changes in lifetime, promising for FLIM biosensors.

Although one dye was clearly superior for monitoring Cdc42,

the others provide a tool chest of dyes that could prove to be

more useful for other targeted proteins. The response of the

dyes to solvent changes did not indicate the extent of their

response to our specific target, Cdc42. Interaction of dyes with

proteins is complex andmultifactorial, so this was not surprising.

The dyes were marginally soluble in water (just enough to enable

protein labeling when low concentrations of DMSO were

included in buffers). This suggested that they interactedwith pro-

tein surfaces rather than extended from the proteins, completely

solvated by buffer. When the dye on AR was exposed to target

protein, this could have changed interactions with specific resi-

dues or the ability of specific atoms in the dyes to undergo

hydrogen bonding with water or protein side chains. Previous

studies have shown that hydrogen bonding to specific atoms

on the dye can have a strong effect and that general solvent ef-

fects play a role as well.37,38 The rigidity and length of the linker

will be important in drawing the maximum response from

each dye.

In the FLIM biosensors, only one fluorophore was needed,

providing advantages. They did not show the complex photo-

bleaching behavior encountered due to differential photobleach-

ing of two fluorophores in FRET biosensors. In the future, simul-

taneous imaging of multiple biosensors can be simplified

because each biosensor uses less of the spectrum.

The biosensors showed the greatest change in overall FLIM (or

phasor location) at lower activation levels (Figures 4D; data avail-

able at Zenodo, https://doi.org/10.5281/zenodo.10654587). This

feature will likely be especially valuable for GTPases, which can

initiate cell behaviors when less than 10% of the protein popula-

tion is active.48,49 The biosensor design used here responds to

endogenous protein, reducing artifacts that come from overex-

pression or substituting target protein with modified analogs.

Combining reduced perturbation with the ability to quantify low

activated concentrations bodes well for the study of low-abun-

dance targets or phenomena driven by low activation levels.
6 Cell Reports Methods 4, 100734, March 25, 2024
We showed that the mero87-CBD biosensor could not only

report the relative subcellular distribution of activity but could

quantify the actual concentrations of activated species at

different locations. We hope that the dyes described here can

be used to provide quantitative readouts of active species for a

range of protein targets.

Limitations of the study
One of the more difficult challenges in using dye-protein conju-

gates as biosensors is delivery of the biosensors to the interior

of cells. A number of methods can accomplish this, including

microinjection,22,24 electroporation,51 bead loading,52 and cell-

penetrating peptides.53 However, these can be substantially

more cumbersome than genetic encoding. More recently, bio-

sensors have been generated by genetically encoding the pro-

tein portion and using membrane-permeable dyes to covalently

attach dyes to proteins within live cells. This has been accom-

plished using unnatural amino acids for site-specific labeling26,54

or through attachment of fluorophores to enzyme fragments that

catalyze attachment (e.g., SNAP-tag55 and HaloTag56). Labeling

of unnatural amino acids with merocyanine dyes in living cells

has already been used to generate biosensors.26

Another issue with dye-labeled biosensors is the propensity of

some dyes to cause aggregation within cells or the cells’ recogni-

tion of the biosensor as a foreign body. Both result in packaging of

the biosensors into vesicles, leading to punctate fluorescence

superimposed on the signal being studied (see Figures 3C–3E

and S1C). The impact of this depends on the kinetics of vesicle

formation. In some cases, no puncta are seen for hours, if at all.

For other biosensors, puncta form within minutes. Our control

studies (Figure S1C) showed that, for the biosensor mero87-

CBD (Figures 3C–3E), the presence of the dye increased the cell’s

propensity to produce vesicles, albeit not to levels that prohibited

our experiments regardingmotility signaling. Finally, themerocya-

nine dyes here show a bi-exponential decay, which may present

difficulties for some types of FLIM analysis. This may be due to

the exposure of the dye to multiple environments or different sol-

vent effects. Further study could improve this property.
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EXPERIMENTAL MODEL AND STUDY PARTICIPANT DETAILS

Cell lines
NIH 3T3 mouse embryo fibroblasts (MEF) were obtained from Clontech (RRID: CVCL_0594), authenticated by Short Tandem

Repeat (STR) profile. HeLa cells were purchased from the American Type Culture Collection (ATCC, https://www.atcc.org/). All cells

were tested for mycoplasma by polymerase chain reaction (PCR). MEF and HeLa cells were maintained in Dulbecco’s Modified

Eagle’sMedium (DMEM) supplementedwith 10% fetal bovine serum and 1XGlutaMax. Before imaging, cells were re-plated on fibro-

nectin-coated coverslips and allowed to attach for at least 2 h. Before imaging, themedia was replaced with Hams/F12medium sup-

plemented with 5% Fetal Bovine Serum and 10 mM HEPES.

METHOD DETAILS

Dye synthesis and protein conjugation
Dyes were synthesized as previously described,48,49 except for the dyesmero81 andmero77, whose synthesis is described below

(Scheme: Synthesis of merocyanine dyes). Production of the WASP domain used as the affinity reagent, and its conjugation with

dyes, was as described in MacNevin et al.,23 a modification of the procedure in Nalbant et al.24

2,3,3-Trimethylindolenine and N-(5-anilino-2,4-pentadienylidene)aniline hydrochloride were purchased from TCI America. Benzo

[b]thiophen-3(2H)-one 1,1-dioxide was purchased from Ambeed Inc. All other reagents were purchased from Sigma-Aldrich. The

following compounds were prepared according to published procedures: 1,2,3,3-tetramethylindolium iodide,57 and 2,3,3-tri-

methyl-1-(3-((3-sulfopropyl)amino)propyl)indolinium bromide.23 Reactions were run using anhydrous solvents. All operations with

dyes were performed under dim light. UV-Visible spectra were recorded on a Hewlett-Packard 8453 diode array spectrophotometer

or Agilent Cary 60 UV-Vis spectrophotometer. Fluorescence spectra were obtained on a Spex Fluorolog 2 spectrofluorometer. NMR

spectra were taken on a Inova-400 or Bruker-500 or Bruker-700 or Bruker-850 spectrometer using deuterated solvents purchased

from Cambridge Isotope Laboratories. Reference peaks of 7.26 ppm (CDCl3), 2.50 ppm and (DMSO-d6) were used for 1H NMR

spectra. Reference peaks of 77.2 ppm (CDCl3), and 39.5 ppm (DMSO-d6) were used for 13C NMR spectra. High resolution mass

spectra were obtained on a Thermo Scientific Q Exactive HF-X mass spectrometer with direct infusion. The synthesis is shown in

Scheme: Synthesis of merocyanine dyes. NMR spectra and high resolution mass spectra of compounds S2, mero81, S3 and

meo77 are available at Zenodo (https://doi.org/10.5281/zenodo.10654587) and in supplemental information (Figures S2 and S3).
Scheme. Synthesis of merocyanine dyes
N-((1E,3E,5E)-5-(1,1-dioxido-3-oxobenzo(b)thiophen-2(3H)-ylidene)penta-1,3-dien-1-yl)-N-phenylacetamide (S2)

A mixture of the benzo[b]thiophen-3(2H)-one 1,1-dioxide (2.73 g, 15.0 mmol) and N-(5-anilino-2,4-pentadienylidene)aniline hydro-

chloride (5.98 g, 21.0mmol) were diluted in acetic anhydride (25mL). Themixture was heated to reflux under argon for 2 h and cooled

to room temperature. The resulting precipitate was filtered, washed with ethyl acetate, and dried under vacuum. The product was re-

crystalized from isopropanol to give 4.16 g dark brown solid (73% yield). 1H NMR (CDCl3, 400 MHz) d ppm 8.21 (d, J = 16.0 Hz, 1H),

8.07 (d, J = 8.0 Hz, 1H), 7.99 (d, J = 8.0 Hz, 1H), 7.89 (t, J = 8.0 Hz, 1H), 7.81 (t, J = 8.0 Hz, 1H), 7.70–7.60 (m, 4H), 7.28–7.14 (m, 3H),
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6.86 (t, J = 12.0 Hz, 1H), 5.41 (t, J = 12.0 Hz, 1H), 2.02 (s, 3H); 13C NMR (CDCl3, 100 MHz) d ppm 178.6, 169.4, 152.8, 144.1, 143.4,

140.8, 138.3, 136.0, 134.0, 133.2, 130.8, 130.0, 128.4, 128.1, 124.6, 122.3, 121.2, 113.3, 23.5; HRMS (positive mode) obsd 380.0946,

calcd 380.0951 [(M + H)+, M = C21H17NO4S].

Mero81

1,2,3,3-Tetramethylindolium iodide (0.15 g, 0.50 mmol), compound S2 (0.21 g, 0.55 mmol), and sodium acetate (0.053 g, 0.65 mmol)

were dissolved in methanol (2.0 mL) and heated to reflux for 10 min. The reaction mixture was cooled to room temperature, concen-

trated via rotary evaporation, and purified by silica gel chromatography using dichloromethane and ethyl acetate. The product was

isolated as 0.136 g blue-olive solid (65%yield). 1HNMR (CDCl3, 400MHz) d ppm8.00 (d, J = 8.0 Hz, 1H), 7.94 (d, J = 8.0 Hz, 1H), 7.81–

7.66 (m, 3H), 7.48–7.39 (m, 1H), 7.28–7.18 (m, 3H), 7.03 (t, J = 8.0 Hz, 1H), 6.92 (t, J = 12.0 Hz,1H), 6.82 (d, J = 8.0 Hz, 1H), 6.38 (t, J =

12.0 Hz, 1H), 5.64 (d, J = 12.0 Hz, 1H), 3.31 (s, 3H), 1.63 (s, 6H); 13C NMR (CDCl3, 100 MHz) d ppm 177.9, 165.9, 156.6, 145.3, 143.9,

143.9, 143.8, 139.8, 134.9, 133.9, 133.6, 128.3, 124.6, 124.1, 123.4, 122.4, 122.0, 120.8, 119.3, 108.0, 99.1, 47.4, 29.9, 28.4; HRMS

(positive mode) obsd 418.1478, calcd 418.1471 [(M + H)+, M = C25H23NO3S].

3-((tert-Butoxycarbonyl)(3-((E)-2-((2E,4E,6Z)-6-(1,1-dioxido-3-oxobenzo[b]thiophen-2(3H)-ylidene)hexa-2,4-dien-1-
ylidene)-3,3-dimethylindolin-1-yl)propyl)amino)propane-1-sulfonic acid (S3)

2,3,3-Trimethyl-1-(3-((3-sulfopropyl)amino)propyl)indolinium bromide (0.420 g, 1.00 mmol), and di-tert-butyl dicarbonate (1.09 g,

5.00 mmol) were mixed with water (0.2 mL). The resulting mixture was sonicated for a minute and then heated at 80�C under reduced

pressure in a rotary evaporator for 30 min. The residue obtained was mixed with S2 (0.100 g, 0.264 mmol), sodium acetate (0.082 g,

1.00 mmol) and methanol (5.0 mL) under argon. The reaction mixture was stirred at 80�C under argon for 30 min. The solvent was

removed under reduced pressure. The residue was purified on a flash chromatography using methanol/dichloromethane mixture

(1:9) as an eluent. The product was isolated as a dark blue solid (105 mg, 58% yield). E/Z isomerism in tertiary amide caused

peak doubling in 1H NMR and 13C NMR. 1H NMR (DMSO-d6, 850 MHz) d ppm 8.03 (d, J = 7.6 Hz, 1H), 7.93–7.89 (m, 2H), 7.87–

7.81 (m, 2H), 7.73 (t, J = 12.8 Hz, 1H), 7.55 (d, J = 13.6 Hz, 1H), 7.50 (d, J = 7.3 Hz, 1H), 7.33 (t, J = 7.7 Hz, 1H), 7.20 (d, J =

7.9 Hz, 1H), 7.12 (t, J = 7.4 Hz, 1H), 6.60 (t, J = 12.8 Hz, 1H), 6.51 (t, J = 12.8 Hz, 1H), 6.07 (d, J = 13.6 Hz, 1H), 3.96 (br s, 2H),

3.22–3.27 (br m, 4H), 2.38 (t, J = 7.4 Hz, 2H), 1.90 (br s, 2H), 1.79 (br s, 2H), 1.62 (s, 6H), 1.41 & 1.27 (2 s, 9H); 13C NMR (DMSO-

d6, 213.7 MHz) d ppm 175.6, 168.3, 158.4, 154.4, 149.5, 143.1, 142.5, 141.9, 140.2, 135.0, 134.0, 133.0, 128.2, 124.0, 123.2,

122.2, 120.4, 119.1, 116.6, 109.6, 100.6, 78.4, 49.0, 47.8, 46.1, 44.4, 44.2, 40.6, 28.0, 27.5, 26.2, 25.6, 24.9, 24.5; HRMS (negative

mode) obsd 681.2316, calcd 681.2310 [(M-H)-, M = C35H42N2O8S2].

mero77

A solution of compound S3 (48 mg, 0.070mmol) in dichloromethane (3.0 mL) was treated with trifluoroacetic acid (1.0 mL) and stirred

under argon for 2 h. Completion of Boc deprotection was confirmed by TLC analysis. Then, the reaction mixture was concentrated

under reduced pressure and the residue was thoroughly washed with diethyl ether. The resulting residue was mixed with iodoacetic

anhydride (50 mg, 0.14 mmol), THF (1.0 mL) and N,N-diisopropylethyl amine (0.33 mmol, 0.057 mL) and stirred under argon for 1 h.

The solvent was removed by rotary evaporation under reduced pressure. The residue was purified on a flash chromatography using

methanol/dichloromethane mixture (3:17) as an eluent. The product was isolated as a dark blue solid (33 mg, 54% yield). E/Z isom-

erism in tertiary amide caused peak doubling in 1H NMR and 13C NMR. 1H NMR (DMSO-d6, 500MHz) d 8.02 (d, J = 7.3 Hz, 1H), 7.92–

7.79 (m, 4H), 7.71 (t, J = 12.0 Hz, 1H), 7.54–7.49 (m, 2H), 7.36–7.31 (m, 1H), 7.24–7.20 (m, 1H), 7.12 (t, J = 7.6 Hz, 1H), 6.97 (t, J =

6.3 Hz, 0.5H), 6.60–6.46 (m, 1.5H), 6.17–6.06 (m, 1H), 5.25 (m, 0.5H), 4.47–4.31 (m, 1.5H), 4.00–3.90 (m, 2H), 3.48–3.36 (m, 4H),

2.46–2.36 (m, 2H), 1.92–1.74 (m, 4H), 1.62 (s, 6H); 13C NMR (DMSO-d6, 176 MHz) d 175.5, 168.1, 167.4, 166.0, 165.6, 158.4,

149.6, 143.0, 142.5, 141.9, 140.1, 136.6, 135.1, 133.9, 132.7, 128.2, 124.2, 123.2, 122.2, 120.4, 118.9, 116.5, 109.6, 100.8, 48.6,

47.83, 47.77, 46.4, 42.8, 42.6, 42.0, 27.5, 27.4, 24.9, 24.8, 24.6, 23.5, �0.5, �4.4; HRMS (negative mode) obsd 749.0860, calcd

749.0858 [(M)-, M = C32H34IN2O7S2].

Lifetime measurements
Lifetimes in vitro and in live cells were collected on a modified laser scanning confocal microscope (Olympus FV1000) equipped with

a UPLFL40X, 1.30 NA objective. The merocyanine dyes were excited at 594 nm using a pulsed supercontinuum laser source (Fia-

nium) at 20 MHz in combination with an acousto-optic tunable filter (AOTF) (Crystal Technologies). The images were obtained

with 256 x 256, 20 ms/pixel, 1.660 s/frame acquisition settings. Lifetime images were averaged over 35 frames for a total acquisition

period of 58 s. The emission was detected with an external GaAsP photomultiplier detector (Hamamatsu: H722P-40). An emission

bandpass filter (Semrock: FF-02-628/40-25) was placed before the PMT to reject unwanted excitation light. A digital frequency

domain approach was used to acquire lifetime measurements (ISS: A320 FastFlim box).23 Calibration of the system was performed

by measuring Texas red, which has a known lifetime of 4.2 ns in water. Processing was done with custom scripts developed in

MATLAB.

The fluorescence decay of each merocyanine dye was acquired with a time-correlated single photon counting fluorometer based

on an ISS Koala automated sample compartment, supercontinuum laser source (Fianium), Hamamatsu photomultiplier tube, and

Becker & Hickl SPC-144 board. For each acquisition, the bin time was 24.43 ps and points were integrated over 60 s. Depending

on the spectral properties of each merocyanine dye the Fianium laser was tuned to either 570 nm or 600 nm while emission was

collected using a 600/25 nm or 625/25 nm bandpass filter placed in the front of the detector. The instrument response was calibrated

by measuring the instantaneous response from an aqueous dispersion of glycogen. Experiments for Figures 4A, 4B, 4D and S1C
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were carried out with a Leica SP8X Falcon microscope, with excitation at 561 nm and emission collected between 570 and 640 nm.

Photobleaching of Cy5 and mero77
Photobleaching curves were measured as previously described.25 In brief, 1 mM dye was dissolved in 1% low-melting point agarose

and sandwiched between two glass coverslips. Samples were imaged on a home-built inverted microscope equipped with a 100x,

NA1.50 oil objective (UPLAPO100XOHR, Olympus) and a scientific CMOS (sCMOS, Photometrics 95B) camera. Samples were

excited with a mercury lamp (U-LH100HG, Olympus) filtered by HQ630/45M (Chroma) and the fluorescence was collected through

an HQ700/75M (Chroma) emission filter.

Calculation of active Cdc42 concentration
The following is based on a similar derivation previously published for the calcium sensor, CG5N.58 The following description has

been included for completeness. The free, pf and bound, pb forms of the biosensors have unique locations within the phasor

plot, defining characteristic lifetimes for both states. Utilizing the property of linear combinations, a phasor p; which contains a

portion of free and bound biosensor,will be located somewhere along a line connecting the two states. This phasor position is given

by the following equation.

p =
½Cdc42�dyeCBD�εbpb+½dyeCBD�εfpf

½Cdc42�dyeCBD�εb+½dyeCBD�εf Equation 1

εf and εb correspond to the relative brightness of the free (dyeCBD) and bound (Cdc42�dyeCBD) states of the biosensor, respec-

tively. The asterisk designates that Cdc42 is in its active, GTP-bound conformation. With knowledge of these phasor locations along

with the relative brightness of the two states, the fraction of bound biosensor, Fb can be calculated.

Fb =

½Cdc42�dyeCBD�
½dyeCBD�

1+
½Cdc42�dyeCBD�

½dyeCBD�
=

εf

εb

kpf � pk
kp � pbk

1+
εf

εb

kpf � pk
kp � pbk

Equation 2

To determine the concentration of active Cdc42, the dissociation constant, KD must be determined. Mathematically, this is pre-

sented through the law of mass action.

KD =
½Cdc42��½dyeCBD�
½Cdc42�dyeCBD� Equation 3

When Equation 3 is inserted into Equation 2 and after some algebraic reorganization, the concentration of active Cdc42 is given by

Equation 5. It is proportional to the dissociation constant and dependent on the fraction of bound biosensor.

Fb =
½Cdc42��

KD+½Cdc42�� Equation 4
½Cdc42�� = KD

Fb

1 � Fb
Equation 5

The dissociation constant, and ratio of free to bound brightness were previously published for mero87-CBD; 186 ± 40 nM and

1/8.9 respectively.23 Pseudo-colored images of activated Cdc42 concentration were generated by first determining the fraction of

bound biosensor for every pixel. This was achieved by projecting the measured phasor p for each pixel on the line connecting pf
Procedures for calculating protein concentrations in
single cells

1. INTRODUCTION

IFLI_Viewer is a GUI developed in Dr. Enrico Gratton’s Laboratory at the University of California, Irvine. The main functions include decode.fli FLIM

data, phasor analysis, and FRET-FLIM analysis. The most recent version is maintained at the Laboratory for Fluorescence Dynamics, named as

Globus for Images. This document gives step-by-step instructions for generating a protein concentration map in single cells using IFLI_Viewer.

Cell Reports Methods 4, 100734, March 25, 2024 e4
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d MATLAB (tested on 2016, 2020, 2022)

d Phasor locations of the active and inactive species, obtained from in vitro data

d FLIM data (.fli format) of single cells

d The cell mask (binary image) generated by ImageJ/Fiji or MovieThresh (see Hahn lab)

3. STEP-BY-STEP INSTRUCTIONS

3.1 Open IFLI View and load .fli data
d Open MATLAB and change the current directory to the directory where IFLI_Viewer is located

d Type in IFLI_View in the command window to run the GUI

d Go to File>Open IFLI File to open an FLIM dataset (*.fli)

d The intensity image will show up, along with the raw phasor plot

e5 Cell Reports Methods 4, 100734, March 25, 2024
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d A cell mask will be applied to clean up the phasor. This can be done under Intensity Image Tools>Apply Mask

3.2 Calculate fraction bound
d Step up phasor locations of active and inactive species
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d Click Calculation Image Tools > Calculate Linear Projection > Calculate Fraction Bound and type in the intensity ratio of the free

and bound states

d To adjust the colorbar of the Fraction Bound Image, click on the Fraction Bound Image window, then go to the MATLAB Com-

mand Window and type in caxis([0 0.2])
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3.3 Calculate concentration
d Click Calculation Image Tools > Calculate Linear Projection > Calculate Concentration and type in the intensity ratio of the free

and bound states, as well as the KD
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and pb (Equation 2). After this, the concentration was determined using Equation 5, with knowledge of the dissociation constant.

Step-by-step instructions for use of the software are shown below.

QUANTIFICATION AND STATISTICAL ANALYSIS

Both the in vitro and in vivo FLIM data were analyzed using home-built software written in MATLAB (see data and code availability).

Statistical details can be found in the figure legends. Data (Figures 1C, and 3B) were shown as mean ± SD.
e9 Cell Reports Methods 4, 100734, March 25, 2024
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